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Time and Contact Management Using 

Outlook: Outlook for the Super User 
Greg Creech 
Time and Contact Management Using Outlook: Outlook for the Super User guides you through the 

advanced areas of Outlook and how Outlook works with other applications. We will export and 

import information with Excel and Outlook; we will perform Mail Merges with Word using Outlook as 

our source. We’ll also lean how Google Calendar and Outlook share calendars. We will learn other 

popular areas including creating custom views and manipulating your data with filters and sorts. 

08 Fall 



  Time and Contact Management Using Outlook:  

  Outlook for the Super User 

Greg Creech 

iaap-hq.org  1 

 

Ta b l e  o f  C o n t e n t s  

Table of Contents ............................................................................................................... 1 

Oops! and Legal Stuff ........................................................................................................ 3 

IAAP and Greg Creech ...................................................................................................... 4 

Introducing Greg Creech ................................................................................................... 5 

The Rules and The Wizard ................................................................................................ 6 

Export and Import ............................................................................................................ 11 

Exporting Contacts ................................................................................................................. 11 

Exporting your Calendar ....................................................................................................... 13 

Office 2013 Export .................................................................................................................. 14 

Import ............................................................................................................................... 15 

Google and Outlook – Calendar Import.......................................................................... 18 

Custom Views ................................................................................................................... 20 

Custom Table Views ............................................................................................................... 20 

Custom Card Views ................................................................................................................ 25 

Business Card ......................................................................................................................................25 

Address Card ........................................................................................................................................26 

Custom Calendar Views ......................................................................................................... 27 

Advanced Group by, Filter and Sort ..................................................................................... 28 

Mail Advanced Grouping, Filtering, and Sorting ................................................................................28 

Mail Group by .................................................................................................................................28 

Mail Filtering ..................................................................................................................................30 

Advanced Sorting Mail ...................................................................................................................31 

Contacts Advanced Grouping, Filtering, and Sorting ..........................................................................32 

Contacts Advanced Filtering ...........................................................................................................32 

Contacts Advanced Sorting .............................................................................................................33 



  Time and Contact Management Using Outlook:  

  Outlook for the Super User 

Greg Creech 

iaap-hq.org  2 

Contacts Advanced Grouping .........................................................................................................34 

Calendar Advanced Grouping, Filtering, and Sorting ..........................................................................35 

Filtering in A Monthly Calendar .....................................................................................................35 

Grouping and Sorting in a Calendar List View ...............................................................................35 

Managing and Creating your own view ................................................................................ 36 

Custom Mail View ..........................................................................................................................36 

Custom Contact Card View.............................................................................................................37 

Custom Calendar View ...................................................................................................................38 

Managing Your Views .........................................................................................................................39 

Reset your View (Be Careful!) ............................................................................................... 39 

Outlook and Word – Mail Merge .................................................................................... 40 

Mail Merge – Form Letters .................................................................................................... 43 

Index ................................................................................................................................. 45 

  

  

  



  Time and Contact Management Using Outlook:  

  Outlook for the Super User 

Greg Creech 

iaap-hq.org  3 

O o p s !  a n d  L e g a l  S t u f f  

 
While I have made every effort to ensure the accuracy of this document, including grammar and 

instructions, I make mistakes. (Surprise!)  If you find an error or want to provide constructive 

feedback, please contact me.  Thank you!  Enjoy Your new Office and this document. 

 

Greg Creech 

Techedutainment Services, Inc. 

P. O. Box 1431 

Pine Lake, GA  30072 

www.gregcreech.com 

 

A few items you should know about me: 

 International Association of Administrative Professionals Business Partner and Member 

 American Society of Training and Development Member 

 Society of Human Resources Management Member 

 Microsoft Office User Specialist Certification – Master Expert and Instructor 

 CompTIA Certified Technical Trainer + 

 A+ Certified Systems Technician through CompTIA 

 Microsoft Certified Technical Trainer 

 2007 Southern Region University Continuing Education Association Award Winner for the 

Top Non-Credit Programs 

 2009 Southern Region Association of Continuing Higher Education’s Faculty Award winner 

for my work at Emory University’s Center for Lifelong Learning  

 Former National Speakers Association Member 

 

Outlook ® is a most excellent product from Microsoft ® Corporation and is part of the Office ® Suite 

(including Office 2007/2010/2013 ® of products and services, including Excel, PowerPoint, Word, 

Access, and other fantastic programs that help me to be productive and profitable. 

 

Copyright © 2015 Greg Creech, Techedutainment Services, Inc..  All rights reserved.  This 

publication, or any part thereof, may not be reproduced or transmitted in any form or by any means, 

electronic or mechanical, including photocopying, recording, storage in an information retrieval 

system, or otherwise, without express written permission of Greg Creech, P. O. Box 1431, Pine Lake, 

GA  30072-1431, www.gregcreech.com. 

http://www.gregcreech.com/
http://www.gregcreech.com/
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I A A P  a n d  G r e g  C r e e c h  

On January 5, 1981, I entered the world of being an administrative professional as the only male 

Steno Clerk in Columbia, SC at Southern Bell. As my manager, Becky Davis, introduced me to all of 

the women, one funny woman exclaimed: “Well, there goes the steno pool; they let a rooster in the 

hen house!” Later in the day, I used an IBM Selectric typewriter to type a proposal. As I typed, I 

noticed the silence in the room and looked up to see everyone staring at me. The funny woman said: 

“I’ve never seen a man that could type like that. Who would’ve thought.” I could type 70 WPM with 

no mistakes. I worked in Sales and Marketing at AT&T in many clerical, administrative, and 

operations management positions. My longest responsibility for over 10 years was as a Compensation 

Manager in Sales and Marketing for various sales organizations , and in 1998, I took an early 

retirement buy out package as an Operations Manager. AT&T supported my comedy, musical, and 

motivational presentations internally and externally, too, so I had the best of both worlds: 

administrative position and entertaining presenter. I continue to enjoy at&t as a customer and 

supplier as I train on and develop Access databases for at&t. 

 

Since 1998, I have pursued my passion and love of technology, education, comedy/humor, music, 

and administration. In April 2006 for Administrative Professional Day, I presented my musical, 

humorous stress management speech at Midlands Technical College with over 650 admins in my 

home town of Columbia, SC. Four months later, I and Mary Stuckey, my neighbor, were at a 

neighborhood meeting and she informed me that she was being installed as President – Georgia 

Division of IAAP. Mary and I have been neighbors for 9 years at that point and we never knew of our 

administrative connections. I told her about my presentations and programs. In November 2006 at 

an IAAP Educational Seminar in Macon, GA I presented my humorous, musical presentation on 

business communication, stress management, and career development entitled “SMILE”. I joined 

IAAP in 2007. The presentation was a hit and IAAP blesses me frequently allowing me to present at 

chapter meetings, conferences, and other events. Being included on this Louisville Summit 

conference is an absolute dream come true for me and I owe much thanks to my sisters in the 

Georgia and South Carolina chapters for all of the persistent and consistent recommendations, 

referrals, prayers, and compliments since the beginning. I hope you enjoy my presentation as much 

as I enjoy presenting it.  
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I n t ro d u c i n g  G r e g  C re e c h  

Shop Talk from The Atlanta Journal-Constitution 

Sunday, Oct. 29, 2000 R3 - JOBS 

Why I Love my Job – Greg Creech 

What I Do: I teach technology courses and make presentations to beginner and expert computer users and professionals.  I use 

humor and the piano.  I train all levels from first-time computer users to systems 

technicians acquiring A+ certification.  As an A+ certified trainer, MOUS expert, and 

technical trainer, my certifications and knowledge give me a career in the technology.  

My humor, the piano, and people keep me in the technology training field. I sing to my 

students sometimes and perform stand-up comedy about computers. 

How I got started:  I won Best Actor in a Supporting Role at Southside Theatre Guild 

for “A Funny Thing Happened on the Way to the Forum” and studied comedy under 

Jerry Farber.  I have played the piano since 8 years of age and had the first personal 

computer with a 1 MB of memory.  In order to learn the PC, I associated the PC with the 

piano  -- both use a language to translate, both have keyboards, and now - both provide 

music and information.  I must admit I miss the days when I only played the piano and 

programmed the PC.  Now, I play the PC and have to program my piano.  In 1998 after 

seventeen years of technology business experience in the corporate market, I decided to 

take a leap of faith on my own. I call my presentations “Showminars,” a combination of a show and a seminar. 

The Best Part:  Hearing the laughter and the comments:  “You have saved me so much time,” and “I remember complicated macros because 

of the way you taught them.” I have a passion for teaching creative people to be more technical and technical people to be more creative – 

Mozart would be proud! 

The Challenging Part:  Explaining why I want my piano in a PC classroom.  “Mainframers” who refuse to acknowledge the existence of the 

PC and the Web.  People who attend training classes because they have to, not because they want to.  Technical people who are not client- 

focused. 

My Favorite Quotes:  “To err is human, to really mess things up you need a computer.”  “Forty-two percent of all households have a 

computer; only eight percent of those know how to use it.”  

What Keeps me Going:  I enjoy combining my love of people, the piano, processors, and humor into a unique speaking and learning 

experience. 
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T h e  Ru l e s  a n d  T h e  W i z a r d  

Outlook contains Rules that can help you organize and automate 

many of your functions and administration of Outlook items and 

folders, particularly your emails.  The Rules can be a bit 

confusing until you get accustomed to setting your rules and 

conditions.  Practice and play around with it; however, be 

careful and read the screens and conditions carefully so you 

don’t accidentally create a rule that blocks and deletes messages 

erroneously based on the rules you create.  The 

Rules activates from your Mail object and the Home 

Tab’s Move Group as pictured above.  The Rules 

menu will open by clicking the Rules button and 

from the menu click Create Rule.  The Rules are 

terrific for automatically deleting or moving Junk, 

Marketing, and other emails without stuffing your 

Inbox and interrupting your workday. 

If you have rules established a menu will display 

showing your rules by using Manage Rules and 

Alerts from your Rules button’s menu. 

 

To create a new rule simply click the Rules Button 

and Create Rule. To edit, delete, and view your 

Email rules and alerts, Click the Manage Rules 

and Alerts in the Rules button menu.  The Rules 

and Alerts screen appears at right 

 

There are a lot of rules types and a lot of actions.  

I encourage you to review  the rules and criteria 

that you can have.  Also, test your rule as soon as 

you create it to ensure that what you intended the rule to accomplish will work.  Also, the 

Rules are NOT 100% correct in its operation and you will see this note – particularly with 

Junk and Adult Content E-mails.     
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Let’s create a rule for Outlook to take action from a specific sender. 
If you create a rule that doesn’t work, the way you 

intend you can edit or delete the rule. 

1. Select an email message from a 

sender that you wish to create a rule. 

2. Click the Rules button and then click 

Create Rule or with your message 

selected, right click the message and 

the shortcut menu at right appears. 

You may click the Create Rule item 

from the cascading menu.  

 

The Create Rule dialogue box appears.  I am using a 

message from LinkedIn as my example and will move it to 

my LinkedIn folder.  Review this screen and determine 

your rules for when you receive a message from your 

sender.  Clicking the Select Folder . . . displays your folders 

to select which folder you would like to move messages. 

1. Select your options in the Create Rule pane.  

Choose your folder if necessary and decide 

if you want to display a New Item Alert and 

notification sound, which you may change for this rule using the 

Browse button in the Play a selected sound section. 

2. Click OK and your messages will move when you get a message from 

that person. 

3. Outlook provides the Success screen at 

right.  You may run this rule to move all 

messages from this person to another 

folder automatically by having the check 

box marked.  I have this checked so all of 

my LinkedIn messages in the Inbox move to my LinkedIn folder. 

4. Click OK. 
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The New Mail Alerts window appears 

since I checked this Option in my 

Create rule menu.  

 

This is a terrific way to store messages from an 

important manager or client rather than have 

these messages mixed with your inbox 

messages; however, you must remember to check the folder for the new email messages from 

the sender.  

 

In the create rule, Dialogue box, Outlook provides the 

Advanced Options button. 

1. You should choose another email to use 

for this exercise or use the same 

email/person and add another rule to 

this sender. 

2. Select your email message for which you 

wish to create a rule and Click the Create 

Rule button. 

3. On the Create Rule menu, Click the 

Advanced Options button, it activates 

the Rules Wizard.  Wow! Scroll 

through and notice all of the various 

conditions such as with specific words 

and actions.  After you select an item 

at the top of the screen Step 1, your 

selected condition appears at the 

bottom of the screen Step 2. I am 

creating a rule that moves messages 

from Facebook to a Facebook folder. 

Select a condition(s) for your emails in 

Step 1. 

4. The blue underlined items are 

hyperlinks to other dialogue boxes for 
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you to complete, such as the specific words in a subject or through a 

specific account.  

5. The Conditions menu appears and is loaded with all types of 

conditions for you to select.  Scroll through and notice them. I am 

moving messages from Facebook to my Facebook Folder.  I clicked 

the specified hyperlink to activate the 

Choose a folder dialogue box.  After 

clicking Next, the screen at right 

appears. 

6. I have had other actions including 

adding a category, Desktop Alert, and 

marking the email as read. 

7. Clicking next will bring the Exceptions 

list for you to choose appropriate 

exceptions for your email rule. I have no 

exceptions.  After making any 

exceptions, Click next. 

 

8. After you determine your conditions and 

exceptions, the final menu allows you to 

name your rule, turn your rule on and 

run it automatically, and finally to 

review and edit your rule. 

9. Clicking Finish completes your rule. 

Rules are very helpful in organizing your emails as they 

enter Outlook and assist in managing tons of emails.   

Again, be careful and test your rule to ensure that what 

you intended the rule to accomplish, it achieves.  
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Now, let’s edit a rule. 

1. Click the Rules button on your Home Tab and from the Menu click 

Manager Rules and Alerts. 

2. The Rules and Alerts dialogue box 

appears. 

3. With the Rules and Alerts Dialogue box 

open, select your rule – I will select the 

LinkedIn rule. 

4. You may edit your rule by using the 

Rule Description at the bottom of the 

dialogue box or you may click the 

Change Rule Tab as pictured here and 

go to Edit Rule Settings. . . This will 

activate the Rules Wizard for you as 

described in the previous section.  

5. Notice from the Change Rule cascading menu you may play a sound, 

display a message box, set your priority, or make other changes to 

the rule from this menu. 

6. Using the Change Rule cascading menu have 

Outlook play a sound for you and I am assigning 

the message to my LinkedIn category.  When 

you click the Play a sound item, Outlook opens 

your folder of .wav or sound files for you to use.  

I am choosing the tada sound.  Click the open 

button to accept this sound. Click OK at the Rules and Alerts Pane. 
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E x p o r t  a n d  I m p o r t   

Using Outlook’s important information, such as contacts and calendar, in other applications is 

necessary in many organizations and popular to share your information with others that do not 

have access to your Outlook objects. We will Export to Excel our contacts and calendar. Then 

we will Import information into Outlook, such as contacts.  

 

We will export a contact folder to Excel and then we will export our calendar to Excel. 

 

 Hot Tip! Exporting works on folders not individual items, such as an 

email or an appointment. Having the Outlook folder or object created with 

your information first is important. If you only want your Outlook Business 

contacts to export, then you would need to copy only your Business 

contacts to a Business contacts folder. Importing works on individual files 

you wish to import. We will use an Excel file to import. 

 

I will create an Excel workbook based on a Contact Folder named Admin/HR to use with all 

of my Administrative Professional and Human Resources 

friends and associates.  

Here’s how to export a contact folder to Excel in Outlook 

2010. 

1. Select the folder you wish to export in 

your Navigation pane. 

2. Next, click your File Tab and select Open. 

Next, click Import. 

3. At the Choose an action to perform: 

window, choose Export to a file and click  

Next. 
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4. At the Create a file of type:  screen, we 

will select Microsoft Excel 97-2003 as 

our file type. Click Next.  

 

 

 

 

 

 

 

5. At the Select Folder from window, the 

folder I selected previously is the 

default; otherwise, I must scroll to 

locate the folder I wish to export. My 

Admin/HR folder selects for me. Click 

Next.  

 

 

6. At the next screen, I am browsing to 

save my Excel workbook in a different 

location. Navigate to where you want to 

store the file and click OK.  Back at the 

Save export file as: box that displays your 

location. Click Next.  

7. Since I am exporting this to a new file, I 

do not need to Map Custom Fields. 

Depending upon the amount data and 

number of items to export, this process 

could take a long time, so prepare 

yourself. Click Finish. 

8. Outlook exports 

your folder to 

Excel, like data 

magic.   
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Here is a screenshot of my Excel worksheet’s first two rows and several columns. 

 

Another popular item to export and use in other applications is your calendar. 

 

1. With your Calendar open, Click File, then trace to and click Open and 

then click Import. 

2. At the next screen we will Export to a file. Click Next after your 

selection. 

3. We will export to an Excel 97-2003 file type, so select that option 

and click Next. 

4. We will export our Calendar and my calendar selects for me ready to 

go. I click Next. 

5. Navigate and browse to where you want to 

store your Excel workbook and change the 

name if you like.  

6. Since I am creating a new Excel workbook, I 

do need to Map Custom Fields and I want 

Outlook to export my appointments in my 

Calendar. I click Finish 

7. The next screen, Set Date Range, is terrific. I 

only want to print from June 1, 2015 to 

September 1, 2015.  Notice the message 

about recurring appointments and tasks. 

Outlook will create individual occurrences for your date range of 

recurring appointments and will stay within your 

specified date range. After setting your date range, 

Click OK. 
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8. Outlook exports my Calendar to Excel for the dates that I want. 

 

Here is a screenshot of my exported information in Excel. 

 A Hot Tip! When I exported the information from Outlook to Excel, my 

entire data format is a General, including the Start, End, and Reminder 

Dates. I used a function in Excel, DATEVALUE, that takes a text string and 

converts the text string to a serial number for the date and then I can 

change the format to Short Date. Formatting your date using the 

DATEVALUE is necessary to perform accurate sorting; otherwise, Excel will 

sort your dates as if they were text, not a date or number. OOPS!  

 

 

Office 2013 changes the Export process a bit. When you 

click the File Tab you will see Open & Export and from 

this menu you will see the Import/Export item.  

 

This activates similar panes that we had with previous 

versions of Outlook, until the File Type pane. We have only 

two choices Comma Separated Values (csv) which works 

with many applications or as an Outlook Data File (pst) 

which only works through Outlook. The other panes and 

process are the same. You may open a CSV file from within 

Excel and then save your file as an Excel (.xlsx) format type.  

 

Office 2013 

Feature 
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I m p o r t  

The import process is a bit trickier than export. Mapping the fields and ensuring consistency 

are import to ensure a smooth Import. Depending on the type of data and the source of the 

import the Import process can be easy or difficult and frustrating. I’ll continue to use Excel as 

my data source and encourage you to do the same. You will need to use an old Excel format 

of .xls for Outlook 2010 and a Comma Separated Value (.csv) format for Outlook 2013. 

 

Here are my best practices to prepare you for the import process. 

 Use Outlook’s headers for importing. I export from Outlook to Excel and then copy 

and paste the first row or field name/column headers from the Outlook Export to the 

file I wish to import into Outlook. I match Outlook’s field names with the data 

associated with each column. 

 Use Excel to act as an intermediary from other programs and format your 

information correctly for text, numbers, and dates. 

 For Outlook 2010, save your Excel file as a 97-2003 version (.xls) and for Outlook 

2013, save your Excel file as a Comma Separated Value file format (.csv).  

 Import the information into a New Folder in Outlook, view your new data, and then 

copy or move the information to another folder, such as Contacts.  

 Create your folder in Outlook before you begin the Import process. 

  

 A Hot Tip to Prepare for importing. First, I copy the column headers 

from an export Outlook contact file in Excel and paste the column header 

in the matching column of the Excel file I wish to import. For example, my 

Excel contact file had a column heading/field name of Home Street Line 1 

and I copied/pasted BusinessStreet, so this field will automatically match 

during the import process.  Finally save your Excel file as a .xls file format 

for Outlook 2010 or as a .csv file format for Outlook 2013.  

Let’s import an Excel contact list into Outlook 2010 and then we will overview the 

differences in 2013. 

1. I have my Excel file ready to import with my 

column headings matching Outlook’s column 

headings for contacts and my columns formatted 

correctly for date, text, and number. In Outlook, 
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Click File and then Click Open and finally Click Import. 

2. Import and Export Wizard activates and I am choosing the Import 

from another program or file in the Choose an action to perform: 

box. I click Next.  

 

 

 

 

 

3. At the next screen, I am using Excel 97-2003 file 

type, so I select that option and click Next.  

 

4. The File to import: and Options areas of this pane 

are important for you. I browse to where I stored my Excel 97-2003 

(.xls) file and open it. The options area is important 

for you to decide how you want to handle 

duplicates. Since I am importing into a new and 

empty folder any of the choices are fine for me, but 

if you import into an existing folder, you would 

probably want Do not import duplicate items unless 

the information on the Excel workbook is more 

current and accurate than the information in 

Outlook. After choosing my location and option, I 

click Next. 

 

5. At the next screen, I am importing my folder into 

my Contacts main folder and will make my new 

folder a sub-folder under Contacts. After selecting 

Contacts, I click Next. 

 

 

6. The next screen is very important for you to 

check your fields and mapping correctly. Since I 

used my best practice guide of my columns 
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headings matching in Excel and Outlook, I have few fields that don’t 

match. My EmailAddress field did not match so I clicked the 

EmailAddress from my Excel file and drug the field name to Outlook’s 

E-mail Address field. The Map Custom Fields pane appears at right. 

This can take time and frustrate you if you do not take my advice. If 

you don’t use the exact column heading your will need to associate 

the correct names between the source data and Outlook. 

7. Another button in the Actions to be performed pane, is Change 

Location. I click this button in order to choose my Outlook Contact 

folder of New Clients that I created earlier. After selecting the folder 

I wish to store these new contacts, I click Finish and Outlook imports 

my information. 

 

Like exporting, Outlook 2013 will import only Comma Separated Value 

(csv) file type or Outlook (pst) file type. The remaining process is the 

same. 

  

Office 2013 

Feature 
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G o o g l e  a n d  O u t l o o k  –  C a l e n d a r  

I m p o r t  

Google and Outlook work through the iCalendar format. Below are the steps from Google 

Calendar’s help system (THANKS for great step-by-step instructions) with my screenshots as 

I accomplish these steps of saving my calendar and importing my calendar to Google.  

 

1. Open your Outlook calendar. 

2. Click Calendar. 

3. Right click on the calendar you want to export > Save as > iCalendar 

format. (I used the File Tab and Save Calendar item to activate my 

Save As feature.) 

4. Click More Options > Date Range > Whole calendar, Detail -> Full 

details. (I am specifying the date range for my calendar and changed 

the Detail to Limited Details, I click OK). 

5. Click OK > Save. 

6. Open Google Calendar. 

7. Next to Other calendars, click the drop down arrow 

> Import calendar. 
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8. Click Choose file > the file that contains your events > Open. 

9. Select the Google Calendar to 

which you'd like to import your 

Outlook events, then click 

Import. 

Google advises you of the process and 

successful completion. 

 

Note:  

The exported .ICS file won't support 

recurring Outlook events or keep the 

Outlook attendees. Instead of 

recurring events, individual events 

will be created for recurring events 

that fall between the dates you've 

selected. 
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C u s t o m  V i e ws  

While Outlook has many standard views from which to choose, Outlook allows you to tailor 

your views to fit your needs. We will customize our various views, such as table or list views, 

Card, Mail, and Calendar views, and we will create your own view. We’ll begin with table 

views.  

 

Our mail and task views by default are in a Table View. A table or list view contains column 

headers or field names with the data in rows beneath the header row. In a table or list view 

sorting, filtering, and adding/deleting columns 

are easy tasks to perform using the View Tab in 

the Ribbon or the shortcut menu. You may add 

columns using the Arrangement group and the 

Add Columns button or by right clicking the 

column header row to receive the shortcut menu 

pictured at right with the Field Chooser item. 

Notice you can remove specific columns with the 

shortcut menu.  

 

Let’s add a field to our mail table view. 

 

1. In your mail view, click Add 

columns in the View tab or right 

click and from the menu click Field 

Chooser. 

2. I will use Add Columns first and the 

menu appears for me to select a field on 

the left part of the screen and click and 

drag it to my desired position on the 

right part of my screen. I may select the 

field and then click the Add button and 

then use the Move up or Move Down 

buttons to move the column to another 
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position. I am adding the Cc field. Add a column from the Available 

columns pane to the Show these columns in this order pane. 

3. Click OK. 

Now, let’s use the Field Chooser item. 

1. Right Click on a column header or field name in your mail view. From 

the shortcut menu click Field Chooser and the pane 

at right appears.  

2. From your list click and drag the field you wish to 

add to the place on your header row that you want to 

add the field. I am adding the sent field after my 

received field.  

3. That’s it! Close your Field Chooser pane with the red 

x on the title bar. 

 Hot Tip! You may rearrange your fields and columns by 

clicking and dragging a column header to the position that you want. 

Outlook displays red arrows illustrating where you are moving your 

column. Also, you may remove a column simply by clicking the column 

header and dragging it away from your header row. Outlook displays a big 

X alerting you that you are removing the column.  

 

Outlook contains several nice views from which you may choose from the 

Change View gallery. You should review these different views to notice the 

differences. Generally, I keep my view on Compact, but at times, I change my 

view to Single for a more concise view or Preview so I may view a few lines of 

the email message in the table view. 

 

1. In your Mail view, Change your view 

to Single. 

2. Click the View Settings button and 

the Advance View Settings for your 

Single view appears. 

3. Click the Other Settings… button and 

the Other Settings pane appears 

offering you many choices in how to 

view your information.   
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4. I use the Column Font… button to change my field 

name row or heading row. When you click the Font 

buttons, the Font dialogue box appears as 

displayed here.  

5. I am changing my column font to Trebuchet MS 

and increasing the size to 9. Make the changes you 

wish and click OK. 

Outlook returns you to the Other Settings Pane. 

 

 Hot Tip! The Other Settings pane contains several items that people like 

to have, such as using Grid Lines, using AutoPreview of messages, and 

adjusting your Reading Pane (which some of these items you may 

accomplish using the Ribbon in your mail view).  

 

1. Back at the Advanced Settings Pane, click the Conditional Formatting 

button. 

2. At this pane, I am changing my Unread Messages 

to the color red using the Font button.  

3. Click OK when complete. 

 

 Hot Tip! You may use the Add button to create your 

own rule for emails from certain people or accounts and 

other items and use the Font… box to determine the 

color and style you want for your rule. This is how you 

may color code your messages from others.  

 

1. Outlook returns you to the Advanced 

Settings Pane, click the Format Columns 

button.  

2. I don’t change these items but you may 

want to change your width to Best fit and 

the Alignment. 

3. Click OK at the Format Columns Pane. 

4. Finally, Click OK at your Advanced View Settings Pane. 



  Time and Contact Management Using Outlook:  

  Outlook for the Super User 

Greg Creech 

iaap-hq.org  23 

We will work with the Advanced Group by, Sorting, and Filtering items in a later section. 

 

Now, let’s use a table view for your contacts and 

customized the contact’s table view. 

1. Navigate to your contacts and in 

the Home Tab and Current View 

group click the More arrow (if 

necessary) and click List. 

2. Outlook displays your information 

in a table view for your contacts. 

There are several table views 

including Email List and Phone as 

displayed here. 

3. As we accomplished in our Mail table view, I 

am right clicking a column header and from 

the shortcut menu choosing Field Chooser. 

4. Next, I click and drag the field I want, in this 

case the Company field, to my column 

header row after File As. 

5.  You may click and drag your column 

headings to rearrange your column order.  

 Hot Tip! Sorting - Also, you may click a column 

header to sort by that column and may click the column 

header again to reverse your sort. You may sort your column 

using the Reverse Sort button on your Arrangement Group of 

the View Tab.  

 

As with Mail, you may customize your view with 

the View Settings button that activates your 

Advanced View Settings pane. My List view 

settings pane appears here.  
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Viewing and printing your calendar in a table or list view is helpful, too.  

1. In your Calendar object, click Change 

View on your View Tab and from the 

Gallery choose List and your calendar is 

in a list or table view.  

2. As with other table views, you may add 

and delete columns, sort your 

information and view your information in  

Groups. I have my calendar Arranged by 

Start Date using the Shortcut menu 

provided when I right click a column 

header and the Arrange By option. Notice 

Show in Groups.  

 Hot Tip! Grouping – You may want Outlook to 

provide better organization and viewing using 

the Group by option. The Shortcut Menu at right 

allows me to Group by the column in which I’m 

working or I may activate the Group by box for 

me to click and drag columns to the box at the 

top of the screen. Display at right I am clicking 

and dragging my Subject column header to my 

Group by box to add this grouping. You may 

click and drag the column header from the Group by box to the column 

heading area to remove the Grouping. The Show in Groups 

option is available in the shortcut menu displayed above or 

through the Arrangement groups More button/arrow 

pictured at right. With the Grouping option the use of 

Expand and Collapse buttons makes viewing your 

information easy.   
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B u s i n e s s  C a r d  

Contacts has Card View and Business Card view that we 

may edit and tailor to our needs. We’ll add fields and 

design an Outlook business card that we may share 

electronically with others. 

1. In your Contacts, on the Home Tab the 

Current View has the Business Card 

view. Click the Business 

Card view button.  

2. Open your contact 

information – you should 

always have yourself as a 

contact so you may use your 

Business Card as part of 

your signature.  

3. With your contact 

information displayed, click 

the Business Card button in 

the Options group (Circled 

at right).  

4. The Edit Business Card pane 

appears for you to add your 

photo, fields of information, 

and other effects for a great 

business card.  

5. Here are some of the items you should accomplish for your business 

card as I have done for my business card. 

 Add your photo or logo using the Image and Change items and 

decide your Layout in the Card Design window, 

 Add a background color if you like and determine the alignment of 

your Image and size, 

 Using the Fields sections add fields and blank lines, 
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 With your field selected (I have my Full Name field selected above), 

use Edit Pane to change your font formatting, 

 Rearrange your fields using the up and down arrows beneath the 

fields window, 

 The Add. . . button displays fields you may add and with your new 

field selected then you may use the Edit pane to format your text 

with your favorite fonts and styles, 

6. After creating your beautiful business card, click OK. 

7. Finally, save and close your contact information. 

 

A d d r e s s  C a r d   

The Address Card view is similar to the good, old 

Rolodex layout. The Address Card editing 

accomplishes through the View Tab and View 

Settings menus. Like our Business Card view we 

will add fields and formatting. 

1. In your contacts, change your 

Current View in the Home Tab to 

Card. 

2. In the View Tab click View 

Settings button. 

3. The Advanced View Settings for 

Card appears. 

4. Click each item, such as 

Columns.., Sort, Filter, etc. 

retrieves additional menus from which you 

may customize your card. 

5. Click the Columns button, the Show Columns 

windows appears and is similar to our adding, 

removing, and moving our fields as we 

accomplished in our table views. 

6. At the bottom of the pane you can change the 

available columns from which you may choose 
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other fields. The Frequently used fields provides plenty of columns 

from which I may work.  

7. Add the fields you want or remove the fields you don’t want and  

move them to your desired location by selecting the field in your 

Show these columns in the order pane and then using the Move Up 

and Move Down buttons to rearrange your order. 

8. After adding, removing, and changing your order of fields, click OK. 

Outlook returns you to the Advance view settings pane. 

1. Click the Other Settings… button which activates 

your Format Card View dialogue box from which 

you may change your Card headings and fields. 

2. Click the Card headings Font… button, the Font 

dialogue box appears for you to 

change your font, styles, and size. 

As displayed here I am changing 

font to Trebuchet MS, keeping 

Bold, and changing my size to 9.  

3. Make your changes and click OK. 

4. Back at the Format Card View, you 

may edit your font for the Card 

fields if you like and change your 

Card width. 

5. After making your changes, click 

OK. Outlook changes your Card view with your new formatting.  

 

Generally, my calendar views of Month, Week, and Day 

serve my purposes, so I do not make many changes to 

my Calendar views. Like Mail and Contacts, you may 

change your Calendar views through the View Settings 

button and the Advanced View Settings Pane. Using the 

View Settings button, I like changing my Monthly 
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Calendar’s font and to show the End time of meetings and appointments.  

1. Navigate to your Calendar and view the Calendar in the Monthly, 

Week, or Day view. 

2. Click the Change View button and from the Advanced View Settings 

for Calendar, click the Other Settings button. 

3. Review the Day and Week options and the Month options and change 

the font and time scales and Show End time, if you like. 

4. Click OK. 

 

My Monthly Calendar displays below with my changes.  

 Hot Tip! Depending upon your screen resolution and having the 

Navigation and To-Do bar display your options may not appear. I had to 

minimize my Navigation Pane in order to view my end time.  

 

While the View and Home Tabs in our Outlook items contain ways of filtering (searching), 

grouping, and sorting our information. There are times when you may need to sort, filter, and 

group by more than one column or field. In the exercises below, I will use advanced group by, 

filter, and sort for my contacts, calendar, and mail.  

 

M a i l  A d v a n c e d  G r o u p i n g ,  F i l t e r i n g ,  

a n d  S o r t i n g  

Mail Group by 
1. Navigate to your Mail and Inbox (or other Mail folder) and choose a 

view. I am using the Compact view. 

2. Using the View Settings button activate the Advanced View Settings 

Pane and click the Group by button. 
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3. The Group by pane appears with the Automatically group according 

to arrangement option checked. Click the box to uncheck it. 

4. I am grouping my fields by From 

in alphabetically (Ascending) 

order and then by Received in 

Newest to Oldest (Descending) 

order.  

5. Click OK at this screen and then 

Click OK at the Advanced View 

Settings pane.  

Outlook provides the grouping levels 

and now you may collapse or expand 

your two groups. Grouping for my 

name with the dates displays here. I have 

my From field expanded and then expanded 

my Tuesday, June 16, 2015 email group. 

 

 Hot Tip! You can add up to four grouping 

levels and you may set your Expand/Collaps 

defaults in the Group by pane.   

 

1. Open your Group By box and then 

click Clear All button to remove your 

grouping.  

2. Recheck the Automatically group 

according to arrangement option box. 

3. Then Click OK and finally click the Advanced View Setting Pane’s 

OK button. 
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Mail Filtering 
Filtering is much like searching for information based on criteria that you set. The filtering 

panes in Outlook are robust and offer many ways of looking at your information. Like Group 

by, our Filtering panes appears through the 

View Settings and Advanced View Settings 

Dialogue boxes.  

1. Activate your Advanced View 

Settings Pane and then click 

Filter. 

2. At the Filter Pane and  Messages 

tab, I am searching for IAAP in 

my search for the word(s) box 

and in the subject field only. 

3. Next I check Where I am the 

only person on the To line. 

4. Click OK at the Filter pane and at the Advanced View Settings Pane. 

5. Outlook displays only messages that meet these criteria and in the 

lower left area of your status bar you will the words Filter Applied. 

6. Return to your Filter box and click Clear All. 

 

There are far too many choices for me to cover in our manual here for filtering. Here are the 

More Choices and Advanced panes that you can filter for information. 
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Advanced Sorting Mail    
While sorting using the Ribbon and shortcut menus is 

easy, this sorts by only one field or column. Advanced 

sorting allows you to sort by more than one field.  

1. In your Mail object and the Inbox (or 

other Mail folder), activate your 

Advanced View Settings pane 

through the View Settings button.  

2. Click the Sort button. 

3. As displayed here I am sorting first 

by the From field, then by Subject 

(both are alphabetical in Ascending 

order), and finally by Received in 

Newest to Oldest (Descending) order.  

4. Click OK at this pane and the 

Advanced View Settings pane. 

Outlook sorts my information with these 

three criteria. The screenshot below 

shows my Inbox in Reading Pane view with my columns and the sort 

arrows denoting the sort order.  

5. Return to your Sort box and click the Clear All button, Next, change 

your sort to Received (descending) if you like.  

6. Click OK at this pane and the Advanced View Settings pane. 
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C o n t a c t s  A d v a n c e d  G r o u p i n g ,  

F i l t e r i n g ,  a n d  S o r t i n g  

Like the Mail advanced grouping, filtering, and sorting options, Contacts and Calendar 

activate the Advanced View Settings pane through the View Settings button, so I won’t keep 

referring to how you get to these options.  

 Hot Tip! Group by and other options are not 

available in the Card, Business Card, Monthly 

Calendar, Week Calendar, and so on views. We will 

use these special views for filtering and sorting but 

will need to use a table or list view for grouping.  

Contacts Advanced Filtering 
1. Navigate to your contacts and use the Card 

view. 

2. Activate your Advanced View Settings pane and 

click Filter. 

3. I click the Advanced tab and then the Field list 

arrow.  

4. From list of fields I navigate to Address fields 

and from the cascading menu click State.  

5. Outlook returns to the Filter Pane. In the Condition 

area I can choose from several options, I am 

choosing is (exactly). 

6. In the Value pane, I am typing GA. 

7. Finally, I click the Add to List button. 

8. Next, from my field choices, I choose City from my 

Address fields. Keep my Condition at contains and 

the Value is Atl. I click the Add to List button. 

9. I click OK at my Filter and Advanced View Setting panes. Outlook 

displays all of my contacts in Atlanta, GA. 

 

Return to your Filter screen and click the Clear All button. 
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Now, I am filtering for IAAP in the Company name 

using my Contacts tab. Click OK here and at the 

Advanced View Settings Pane. Outlook displays only 

the folks that have IAAP in the Company name. 

 

I return to my filter pane and click Clear All. 

 

 

Contacts Advanced Sorting 
1. In your Card view for Contacts, 

activate your Advanced Settings 

Pane and click the Sort button. 

2. Using the Sort window, I am sorting 

first by State, then by Company, 

then by Last Name, and finally by 

First Name. I keep all of these text 

sorts in alphabetical (Ascending 

order). 

3. Click OK at this screen and the 

Advanced View Settings pane. 

 

4. If your sorted fields are not in your 

view, Outlook will alert you with 

the dialogue boxes displayed below. I have the State, Last Name, 

and First Name fields included in my Address and File As items so I 

do not need to add them to my view, but I do need to add Company. 
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Outlook displays my information as I like. 

5. Return to your Sort screen and Clear All. 

Contacts Advanced Grouping 
1. In your Contacts, change your view 

to List. Grouping only works in a list 

or table view. 

2. Activate your Group by box through 

the View Settings button and the 

Advanced View Settings pane. 

3. I am grouping my contacts by State 

and then by Company. 

4. Click OK at the Group By Pane and 

the Advanced View Settings Pane.  

 

Here is my screen showing MO 

and the companies that I have 

contacts in Missouri.  

 

 Hot Tip! You may 

accomplish the same 

functionality using the 

Group by box at the top of 

your heading row as display 

here. The Group by box 

illustrates my primary group (State) and my secondary group (Company). I 

can click theses fields and drag them off of the Group by box to quickly 

remove the grouping. I can click other column headers and drag them to 

the group by box to create groups for me.  
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C a l e n d a r  A d v a n c e d  G r o u p i n g ,  

F i l t e r i n g ,  a n d  S o r t i n g  

As with Contacts, the special Calendar views (Monthly, Day, Week) only allow Filtering for 

your appointments, events, and meetings. We will filter in a Monthly view and then use a 

table or list view for grouping and sorting. 

Filtering in A Monthly Calendar  
1. With your calendar in the 

monthly view, click the View 

Settings button and from the 

Advanced View Settings click 

Filter. 

2. I click the More Choices and then 

using my Categories… button, I 

select the IAAP category.  

3. I click OK at the Filter and 

Advanced View Settings pane. 

4. My Monthly calendar only 

displays my IAAP category for 

meetings and appointments. 

5. Return to your Filter screen and Clear 

All. 

 

At right I am filtering for the letter W in the 

subject field of my Appointments and 

Meetings. My calendar displays only those 

items that have W in the subject. 

 

 

 

Grouping and Sorting in a Calendar List View  
Grouping and sorting are similar and you need to use your List view to accomplish this view. 
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1. With your calendar in a List view, activate 

your Group by box. 

2. I am grouping by Category and then by 

Subject. 

3. After clicking OK at this pane and the 

Advanced View Settings pane, Outlook 

displays my information first by Category 

and then by Subject.  

4. After viewing my results, I return to the 

Group by pane and click the Clear All 

button. 

 

Next activate your Sort box and sort your list as 

you like. I am sorting by Subject and then by 

Start. Outlook displays my list with this sort. I can 

quickly remove the sort and sort or group by other 

columns and fields by clicking the column header 

or field name. 

 

 

 

Now, that we know how to edit, enhance, sort, filter, and so on using our existing views in 

Outlook. We will create our own view based on a current view. This process is the same for 

all of our Outlook objects. I will create a view for Mail, Contacts, and Calendar.  

 

Custom Mail View 
The View Tab has the Change View, which we have used to move from one 

view to another, such as from Compact to Single. In this button’s menu,  

you will notice Manage views, which we will accomplish after creating our 

own view, Save Current View as a New View and Apply View to Other 

Mail Folders Options. We will save our current view first and then 
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customized our very own view. 

1. In your Mail and at the Inbox (or other folder), 

click the Change View button and from the 

menu click Save Current View as a New View… 

item. 

2. At the Copy View pane name your view (I’m 

naming my view Greg’s Email View) and decide 

where you want to use the view (I keep All 

Mail and Post folders selected). 

3. Click OK. 

4. Next, click your View 

Settings button. The 

familiar Advanced View 

Settings Pane appears and 

using the previous sections 

as a guide set all of these 

items that you wish. I have 

set my columns, group by, 

sorting and other settings 

for this view. Make your 

selections and click OK. 

5. Viola! You have your own 

view and appears as a selection in your Change View box.  

 

Custom Contact Card View 
Thankfully, we use the same process as Mail for our custom 

contact view. I am using my Card view.  

1. In your contacts, click the Change View 

and the Save Current view as a New 

View…  

2. Next, name your contact view and decide 

the use of the view. My view name is 

Greg’s Card View and used on All contact 
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folders. 

3. Click OK. 

4. Click the View Settings button and as with Mail the familiar 

Advanced View Setting pane appears for you to make your custom 

view modifications. 

5. After modifying your columns, settings, and sorting, click OK. Now, 

this view is in your Change View menu. 

 

A popular view is changing your list view for contacts with the columns, 

sorts, and other information that you like for your contacts. 

Custom Calendar View 
For my calendar, I am creating a category list view. 

Following the steps above save your current calendar 

view as new view and name it.  

 

I am filtering for certain Categories. 

 

You may create views for all of your Calendar 

views and reuse them and edit them as you like. 

 

 

 

 Hot Tip: Excel workbook based on a Table 

View - Using a table view you may copy your 

view and paste the information in Excel. In your 

table view, simply press CTRL + A to select all of your information and then 

press CTRL + C to copy the information in your view. Open Excel at a blank 

workbook and in cell A1 press CTRL + V to paste your information in Excel. 
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M a n a g i n g  Y o u r  V i e w s  

In the View Tab and the Change View button for all of your Outlook 

objects, you have the choice of Manage Views. The Manage views pane 

displays below for my Calendar views. This is where you can modify (edit), 

delete, rename, create a new view, and perform other high-level actions 

for your views. This organized window provides a brief description of your 

view. 

 

 

 

 

 

 

 

 

 

 

 

 

 

A button I never use is the Reset View button. This will restore your view 

to the default settings and loose in customization. OOPS!. 

If you click this button, Outlook warns you about being sure of yourself 

with the dialogue box below. I click No, because the Undo button works 

on this! However, if you totally mess up a view, this can be a handy 

button to use. 
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 O u t l o o k  a n d  Wo rd  –  M a i l  M e r g e  

Outlook and Word work well with each other in using Word’s Mail Merge Feature. You may 

use Word to connect to your Outlook contacts or you may use Outlook to connect to Word. 

We will overview being in Outlook and using the Mail Merge feature from within Outlook. 

You may use a view, selected contacts, or a folder to use with Mail Merge. I’ll use a view first 

and then a folder for a label and a letter Mail Merge. 

 

Let’s create labels based on a category view for your contacts. 

 

1. I have my view at Categories for Summit VIC (Very Important 

Customers) and with this category selected and the group 

expanded, I press CTRL + A to select all of the contacts. 

2.  I click Mail Merge in the Actions Group of the Home Tab. 

3. The Mail Merge Contacts pane appears. I am making these 

selections: 

 All contacts in current view, 

 All contact fields 

 I’m using a New document 

 I am saving this category view 

of contacts as a permanent file 

titled Summit VIC for future 

use 

 Finally, I am using Mailing 

Labels to a new Document 

4. I click OK. 

5. Outlook initializes Word 

6. The message at right appears 

and I click OK. 

7. The Mail Merge Helper dialogue 

box appears and I click Cancel. I 

will use the Ribbon and the 

Mailings Tab to accomplish the Mail Merge. 
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8. First, I click the Start Mail Merge, 

which has Labels selected form me, 

but I click the Labels item again and 

the pane displays for me to choose the 

Labels I want.  I am using good, old 

Avery 5160 for my labels. After 

clicking OK Word warns me that it is 

changing my layout and deleting the 

current layout, I click OK. 

9. Since I am using my Outlook category, 

I do not need to Select Recipients, 

but I do want to Edit my Recipient 

List. After clicking this button, the Mai 

Merge Recipients pane appears for 

you to deselect clients that you do not 

want in the merge by click the check 

mark to remove the check and this 

recipient from the Mail Merge.  

10. Next, I click the Sort button and from 

this pane I am sorting my Last Name 

and then by First Name.  I click OK. 

 

 Hot Tip! You can filter, check for 

duplicates, and manipulate your data in 

many ways for your Mail Merge. Since I 

want to use all of the contacts, I am not 

filtering my information, but you may filter for 

company, state, and any of the other fields.  

 

11. With my cursor in the first label, I click the 

Address Block button and the pane at right 

appears and Outlook with Word matched 

my field perfectly; otherwise, I would 

need to Match my Fields.  I make my 

choices for the name format, Company, etc. I click OK. 
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12. I highlight or select the <AddressBlock> field in the 

first label and right click the selection. I use the Mini 

Toolbar to format my label. As displayed I am 

changing my font size, center the address block, and 

changing the color.  

13. IMPORTANT! It is easy to forget to clcik the Update 

Labels button. This vital button updates the formatting and 

adds the Address Block to all of the other labels. I click this 

button after I make my changes to the first label and Word 

updates all of my labels. 

14. Next, I click the Preview Button and Word displays my 

information. After previewing my information, I had to go 

back and reduce my font size and paragraph spacing to more 

information would fit on the labels. After making my spacing and 

font size changes, I preview my results, again.  

15. Finally, using the Finish and Merge button’s menu I am 

clicking Edit Individual Documents. Because I need to 

correct more spacing issues and I want to save this label 

document to reuse later as a file, I am choosing the Edit 

Individual Documents. At the next dialogue box, I want to 

Merge all Records and I click OK. Word creates a new document 

Labels1 which I can edit individual labels for spacing and font size 

for large addresses, company name, etc. I save make my edits and 

save the document and I save my mail merge document so I may use 

this Mail Merge again without going through these steps. 

 

 Hot Tip! Mail Merge Wizard. At the beginning, I did not 

use the Mail Merge Helper instead I used the Mailings 

Tab in the Ribbon. If you are not familiar with Word’s 

Mail Merge process,  you should use the Step-by-Step 

Mail Merge Wizard which provides a six step task pane 

for you to use as a guide for your mail merge creation.  
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Thankfully, the process for Outlook and Word Mail Merge is similar for Form Letters. We 

will use a folder in Outlook and we will use a form letter in Word. 

 

Let’s create a form letter in Word using an Outlook folder. 

 

1. I select my contact folder named VIC (Very Important Customers) in 

my Address Card view. 

2. Outlook and Word uses your current view for the fields and contacts 

you wish to merge. 

3. I click the Mail Merge button 

on the Home Tab and then 

from the Mail Merge Contacts 

pane I browse to locate my 

form letter and open it. 

Outlook opens and verifies 

the mail and places the path 

to the file in my Existing 

document box. 

4. I am saving this data from 

Outlook in another Word 

document file to use later. 

and I have a document type of Form Letters and will merge to a New 

Document. I click OK. 

5. Word opens with my document. I click the Mailings Tab and Edit 

Recipient List button. From that pane, I change my sort and can filter 

my contacts. I click OK. 

6. At the top of my form letter, I insert the Address 

Block by clicking the Address Block button. From the 

Address Block dialogue box, I must Match Fields, so 

I click the Match Fields button. From this pane, I 

match Address 1 to the Mailing_Address field using 

the drop down arrow list. I click OK and my address 

block looks great.  
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7. In my greeting after the word Dear, I type a space and click 

the Insert Merge Field button from the list I choose Name.  

8. Word inserts the <<Name>> field for me and I type a 

comma. 

9. I preview the results and all looks fine. I complete the Mail Merge by 

Finish & Merge and choose the Edit Individual Documents item. Word 

creates another document with a page for each contact. I can modify 

individual letters to add a personal touch and I can modify 

formatting on an individual letter. I save the document for 

documenting my correspondence and to reuse.   
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